AEC (UK) BIM Technology Protocol for GRAPHISOFT ARCHICAD

Additional detail and enhancements for the practical implementation of the AEC (UK) BIM Technology Protocol for GRAPHISOFT ARCHICAD users.

Version 2.0  January 2016  Updated to reflect current working practices and software application.
AEC (UK) BIM Technology Protocol for GRAPHISOFT ARCHICAD

Contents

1 Introduction
   1.1 Background
   1.2 The Committee
   1.3 Disclaimer
   1.4 Scope
   1.5 Update Procedure
   1.6 References
   1.7 Definitions

2 Best Practice
   2.1 BIM
   2.2 Drawing Production

3 Implementation Planning
   3.1 Roles and Responsibilities
   3.2 Project BIM Execution Plan (BEP)
   3.3 Project BIM Meetings

4 Collaborative BIM Working
   4.1 Common Data Environment (CDE) core principles
   4.2 Validation
   4.3 Legal
   4.4 Data Security & Saving
   4.5 BIM access by non-authors

5 Interoperability
   5.1 Introduction
   5.2 Incoming CAD/BIM Data Management
   5.3 Intended Use of Model
   5.4 Data Exchange between Software Platforms

6 Model structure(s)
   6.1 General Principles
   6.2 Division
   6.3 Referencing

7 Modelling Methodology
   7.1 Model Development Methodology
   7.2 Graded Component Creation
   7.3 Drawing Compilation
7.4 Spatial Location & Co-ordination 25
7.5 Units and Measurement 27
8 Folder Structure and Naming Conventions 28
  8.1 Introduction 28
  8.2 Project Folder Structure 28
  8.3 General Naming Conventions 28
  8.4 File Naming 28
  8.5 Division Naming 29
  8.6 Library Object Naming 31
  8.7 Object Property Naming 32
  8.8 View Naming 33
  8.9 View List Scheduling 34
  8.10 Data Organisation 34
  8.11 Sheet Naming 34
9 Presentation Styles 35
  9.1 Introduction 35
  9.2 AEC (UK) Compliant Materials 35
  9.3 Annotation 35
  9.4 Text Assignment 35
  9.5 Line Weights 36
  9.6 Line Patterns 37
  9.7 Line Styles 37
  9.8 Hatching and Filled Regions 37
  9.9 View Templates 37
  9.10 Dimensioning 37
  9.11 Drawing Borders and Title Blocks 38
  9.12 Symbols 38
  9.13 Copyright 38
10 Resources 39
  10.1 Introduction 39
  10.2 Software 39
  10.3 BIM Content / Resource Libraries 39
  10.4 Keynotes 41
  10.5 Custom metadata 41
  10.6 Keyboard Shortcuts 43
11 Appendices 43
  11.1 Model File Naming Codes 43
  11.2 Project Folder Structure 44
1 Introduction

1.1 Background

The AEC (UK) BIM Standard was released in November 2009.

Version 2.0 of the AEC (UK) BIM Protocol was published in September 2012 to improve the process of design information production, management and exchange. The protocol was published with specific supplements for both Autodesk REVIT and Bentley.

This additional published supplement provides specific application of those protocols for GRAPHISOFT ARCHICAD. Version 1.0 was first published in March 2013. This document is Version 2.0.

Copyright Notice:

It is important to note that this standard will only become truly useful if as many companies adopt it as possible. To that extent, it may be freely distributed and used in any format necessary, provided credit is given to the committee.
1.2 The Committee

The GRAPHISOFT sub-committee has representatives from architectural, engineering and construction companies in the UK, large and small, hence the adoption of the AEC (UK) moniker. The BIM committee is working together to realise a unified, usable, co-ordinated approach to Building Information Modelling in a design environment.

Committee

<table>
<thead>
<tr>
<th>Name</th>
<th>Company</th>
<th>Email</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rob Jackson (Chair)</td>
<td>Bond Bryan</td>
<td><a href="mailto:bim@bondbryan.co.uk">bim@bondbryan.co.uk</a></td>
</tr>
<tr>
<td>Adrian Harms</td>
<td>Graphisoft UK</td>
<td><a href="mailto:aharms@graphisoft.co.uk">aharms@graphisoft.co.uk</a></td>
</tr>
<tr>
<td>Rob Kalocay</td>
<td>Graphisoft UK</td>
<td><a href="mailto:rkalocay@graphisoft.co.uk">rkalocay@graphisoft.co.uk</a></td>
</tr>
</tbody>
</table>

Contributors

<table>
<thead>
<tr>
<th>Name</th>
<th>Company</th>
<th>Email</th>
</tr>
</thead>
<tbody>
<tr>
<td>James Anwyl</td>
<td>HOC Group Ltd</td>
<td><a href="mailto:janwyl@hocconstructionuk.com">janwyl@hocconstructionuk.com</a></td>
</tr>
<tr>
<td>Stuart Clark</td>
<td>Constructive Thinking Studio</td>
<td><a href="mailto:stuart@constructivethinking.co.uk">stuart@constructivethinking.co.uk</a></td>
</tr>
<tr>
<td>Howard Gill</td>
<td>Graphisoft UK</td>
<td><a href="mailto:hgill@graphisoft.co.uk">hgill@graphisoft.co.uk</a></td>
</tr>
<tr>
<td>Mark Hindley</td>
<td>Penoyre and Prasad</td>
<td><a href="mailto:m.hindley@penoyreprasad.com">m.hindley@penoyreprasad.com</a></td>
</tr>
<tr>
<td>Karl Thurston</td>
<td>LSI Architects</td>
<td><a href="mailto:karl.thurston@lsiarchitects.co.uk">karl.thurston@lsiarchitects.co.uk</a></td>
</tr>
<tr>
<td>Paul Tunstall</td>
<td>HLM Architects</td>
<td><a href="mailto:paul.tunstall@hlmarchitects.com">paul.tunstall@hlmarchitects.com</a></td>
</tr>
</tbody>
</table>

1.3 Disclaimer

All the advice outlined in this document is for information only. The authors and contributing companies take no responsibility for the utilisation of these procedures and guidelines. Their suitability should be considered carefully before embarking upon any integration into your current working practices.

None of the recommendations in this document are intended as a replacement for companies who already have an AEC (UK)-based or BS1192-compliant system.

1.4 Scope

This supplement is intended to support all BIM work undertaken using GRAPHISOFT ARCHICAD across a practice, or on a specific project, unless otherwise dictated by the client.

The AEC (UK) BIM Technology Protocol for GRAPHISOFT ARCHICAD builds on the procedures and methodologies defined in the AEC (UK) BIM Technology Protocol and should be read in conjunction with that document.

Terminology and reference to functionality is based around the GRAPHISOFT ARCHICAD platform.
1.5 Update Procedure

Proposed changes and additions to this standard should be submitted in writing with accompanying examples, discussion, or other supportive material to the GRAPHISOFT sub-committee. Feedback will be gathered and continuously reviewed; they will be collated to form new revisions at appropriate intervals.

It is expected that this standard will undergo a relatively rapid evolution process, as the industry adapts to the implications and advantages of BIM methodology.

1.6 References

1.7 Definitions

The following terms are provided in addition to those included in the AEC (UK) BIM Protocol and are terms specific to GRAPHISOFT ArchiCAD and are referred to throughout this protocol.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attributes</td>
<td>ARCHICAD utilises a series of ‘attributes’ which are designed to manage the project. These include layers, line types etc.</td>
</tr>
<tr>
<td>BIM Server / BIMcloud</td>
<td>A server system specifically for the storage and management of ARCHICAD Teamwork files.</td>
</tr>
<tr>
<td>GDL</td>
<td>Geometric Description Language. ARCHICAD’s standard object format.</td>
</tr>
<tr>
<td>Hotlink</td>
<td>An external file referenced into other ARCHICAD files.</td>
</tr>
<tr>
<td>IFC</td>
<td>Industry Foundation Classes, the international file format, maintained by buildingSMART for the exchange of Building Information Models.</td>
</tr>
<tr>
<td>Layout</td>
<td>The source structure of published drawings.</td>
</tr>
<tr>
<td>LCF</td>
<td>ARCHICAD container file for Libraries.</td>
</tr>
<tr>
<td>Masters</td>
<td>Master layout sheets contain title block information, which appears on layout sheets using a particular master.</td>
</tr>
<tr>
<td>Office Template</td>
<td>This is the office generic template setup by the company BIM Manager and the basis for Project Templates.</td>
</tr>
<tr>
<td>PLA</td>
<td>Archive project file format.</td>
</tr>
<tr>
<td>PLN</td>
<td>Single user project file format.</td>
</tr>
<tr>
<td>PMK</td>
<td>ARCHICAD external Drawing file format.</td>
</tr>
<tr>
<td>Profile</td>
<td>Sectional 2D shape used to represent complex model elements.</td>
</tr>
</tbody>
</table>
Project Template
A template created specifically for a particular project which will contain project specific information.

Teamwork
A type of ARCHICAD project which facilitates multiple-user access using object-level database technology.

TPL
Template file format

View
A generated rendition of graphical or non-graphical information (a plan, section, elevation, schedule, or other view of a project).

2 Best Practice

2.1 BIM

2.2 Drawing Production

3 Implementation Planning

3.1 Roles and Responsibilities

3.2 Project BIM Execution Plan (BEP)

3.3 Project BIM Meetings
4 Collaborative BIM Working

4.1 Common Data Environment (CDE) core principles

4.2 Validation

4.3 Legal

4.4 Data Security & Saving

See the generic AEC (UK) BIM Technology Protocol.

Backup procedures for non Teamwork BIM Projects will follow the generic protocols but backup procedures for Teamwork / BIM Server / BIMcloud Server projects will differ.

All references to the BIM Server refer to both the BIM Server and the BIMcloud Server.

All users on a Teamwork project should send and receive their data to the BIM server / BIMcloud Server regularly, at least at hourly intervals and always at the end of the day.

The BIM Server / BIMcloud Server can have two backup procedures. A scheduled backup can be set to run at predefined intervals. Always check the set interval at the beginning of a project and adjust as required. A four hourly interval would give at least two backups per day. The Backup will save a complete copy of the project into the Project Backup folder with control over how many of these to keep. It is advisable to set this to keep at least two whole day’s backups. The general office backup procedures will then back these up for off site storage.

The second BIM Server / BIMcloud Server backup which can be scheduled is the saving of a PLN file into the BIM Server / BIMcloud Server Project Backups folder. This can be scheduled for a specific time but will only be prompted for execution when a client machine sends and receives. It is therefore advisable for an appointed person to be responsible for setting the scheduled time and carrying out a send and receive immediately after. A typical time for this would be 30 mins prior to the end of the working day.

An alternative to the scheduled saving of a PLN as above, is for the appointed person to manually save a PLN file from the Project, to a specific Backup folder in the Main Server Project Folder. These backup PLNs should have the date added to the name of the Project. These can then be manually deleted as their necessity is deemed to be superseded.

Note: When writing scripts for automatic backup procedures, ensure that the ARCHICAD BIM Server / BIMcloud Server Project Backup folders are included but that the live data files are excluded unless a script is set to stop the BIM Server during backup.
4.5 BIM access by non-authors

BIM data for any project should be reviewed at regular intervals by the person responsible for the project, although team members should exert a duty of care when working on projects.

Ensure that users accessing project files have the appropriate experience for the level of access they are given. BIM Explorer (BIMx) is a useful tool for reviewing models as this will not allow modelled elements to be amended.

Information should be reviewed as a non-editable file such as PDF or DWF.

A Teamwork environment gives the greatest control over a user’s editing rights.
5 Interoperability

5.1 Introduction

5.2 Incoming CAD/BIM Data Management

5.3 Intended Use of Model

5.4 Data Exchange between Software Platforms

See the generic AEC (UK) BIM Technology Protocol.

Data exchange should be in line with recommendations made in Annex B2 of BS1192:2007+A1:2015. In addition the following recommendations are made for use with GRAPHISOFT ARCHICAD.

5.4.1 CAD data transfer

It is important to understand that in order to issue information in a CAD format, such as DWG, there are settings available to the user to control the final output. The settings should be carefully considered and setup by the person responsible for use by users.

These translators should be available from a central location. Translators should be reviewed with each software update.

5.4.2 BIM data transfer

The international standard for interoperability between BIM software is that developed by buildingSMART, namely the IFC (Industry Foundation Classes) file format which is registered with ISO as ISO16739. The current version supported by over 130 software packages is IFC 2x3. A full list of compatible software is available at: http://www.buildingsmart-tech.org/implementations/implementation/implementations.

Review with each party the software they are using but in particular the version, and that they have verifiable file exchange using IFC 2x3. Ideally this should be the latest version of the software although this is not always possible.

Always check the Graphisoft website for the latest information and releases of updates to the IFC Add-on. They do not necessarily coincide with Updates for the main package.

Again, like CAD export, there are translator settings to be configured. Translator settings vary depending on:

- The software to be exported to
- The intended use of model i.e. coordination, analysis, quantification, facilities management etc.
These translators should be available from a central location. Translators should be reviewed with each software update.

More information is provided by GRAPHISOFT here: [http://www.graphisoft.com](http://www.graphisoft.com)

It should be noted that successful data exchange through IFC is dependent on a number of factors:

- Understanding of what the recipient requires in the form of geometry and data
- Accurate modelling and data insertion by the ARCHICAD user
- Selection of the correct translator settings prior to export
- Successful data exchange from one party to another (some file exchange methods can cause corruption)
- The quality of the IFC implementation of the receiving software
- Correct import of the IFC file by the recipient

In order to assist data exchange with certain software, GRAPHISOFT had produced a number of add-ins for other software, in particular Autodesk REVIT products. The information for the add-ins should be passed to those using this software for improved interoperability.


5.4.3 Other data transfer

Other data transfer methods, both import and export are available for ARCHICAD users. As with any data exchange it is recommended that tests are carried out between ARCHICAD and the receiving software.
6 Model structure(s)

6.1 General Principles

6.1.1 Segregation of files - sub-models

There are a number of distinct reasons for creating segregation of files within GRAPHISOFT ARCHICAD. These models are specifically referred to in BS1192:2007+A1:2015 as sub-models, which are defined as a 'model included as an instance in another model'. The reasons for developing sub-models in ARCHICAD include:

- **Replication** – Where modelling elements are repeated on a number of occasions these are best linked into other files. e.g. hotel bedrooms in a hotel complex or toilet cores which are the repeated throughout a building.

- **Reference** – Often it is best to split files for reasons of file management or data safety. E.g. a structural file linked into a building model or a grid file linked into a structural model. This prevents accidental editing.

- **Split level projects** – Projects with split levels can be managed by splitting the project at appropriate points and then linking these to a combined model.

- **External source** – Model or drawing files from external sources that are required to be linked into ARCHICAD files. See 6.3.2 External reference information, for more detail.

- **Geospatial referencing** – See 7.4 Spatial Location & Co-ordination for more detail.

- **File size** – Whilst it is generally not recommended to split buildings, sometimes file size can be an issue due to a combination of hardware specifications, overall project size and project organization. There are no hard and fast rules although project files over 1GB should generally be avoided.

Segregation of models should therefore be carefully considered at the outset and be appropriate for the type, scale and requirements of the project. More information on the use of sub-models is covered in Section 6.2.
6.1.2 Segregation of files - models and drawings

Models and drawing layouts can be retained in the same file or the model and drawing layouts can be placed into separate files.

The following should be considered when retaining layouts within the same file as the model.

- Size of file(s)
- Speed of file(s)
- Access requirements for multiple user(s) – particularly where Teamwork is not available
- Data safety

It is then possible to place Views directly from the model file onto layouts in the layout file. Alternatively, external PMK files can be written out from the model file and these can then be placed onto layouts in the layout file. This keeps file size down and has benefits for data security.

Where files are broken down in this way it is very important to decide on an appropriate folder structure and maintain it for the duration of the project. It is advisable to keep these files and folders on the same server.

6.1.3 Segregation of ownership

Where it is necessary for more than one person to work simultaneously on a project then the most efficient method is to use Teamwork.

In Teamwork data can be segregated by user rather than needing to split a project into separate files for different people to work on.

Data can be split in a number of ways. e.g. by stories (floors), layers, zones etc. Agreement of how the Teamwork project will be segregated should be agreed at the outset between the team members, but may change throughout the life of a project.

In Teamwork specific Roles can be established giving access to pre-agreed functionality. Roles and access rights should be documented and each user should be allocated a role appropriate for their level of expertise / ability. Roles will be Office wide rather than project specific, but can be allocated to users for a particular project as appropriate. Roles can be changed at any point subject to agreement with the person responsible.
6.2 Division

6.2.1 Hotlinks generally

Models in ARCHICAD can be sub-divided into a series of files and then linked together by what are known as Hotlinks. Both solo projects and Teamwork projects can be sub-divided if necessary. There will normally be a host file into which the modules or solo files will be referenced using Hotlinking.

On importing a source file into a host file care should be taken to ensure the source file is placed on the correct storey (floor) and that it is placed on the correct master layer. The master layer allows the user to turn off the whole link by switching off one layer. Layers should be created accordingly for this process.

These Hotlinks once inserted are then managed through the Hotlink Manager (File > External Content > Hotlink Manager).

It is possible to have more than one level of Hotlinking. E.g. Hotlink files ‘nested’ into Hotlinks which are then Hotlinked into a subsequent host file. The deeper the nesting the more complex control becomes.

A Model Matrix (see the supporting document AEC(UK)BIMTechnologyProtocol-ModelMatrix-v2.0) will be required to explain and communicate the linking methodology with a key diagram to assist.

*Note*: Where hotlinks are utilised care should be taken with the management of attributes. Attributes need to be kept in step between files. This is best achieved with a master Attribute file for a project into which all new attributes are added and from which the attributes of all other project files are propagated.

6.2.2 Hotlink files on large projects

In large projects where multiple buildings, and therefore multiple hotlinks are required, care should be taken not to create overly complex relationships. The facility in Hotlink Manager to ‘Skip Nested Modules’ may need to be used to limit updating delays during use. It is also very important that folder structures for the location of project files are set at the outset and maintained throughout the project. It is advisable to keep all files for a project on a single server.

These multi-building projects should be regarded as model projects only, therefore containing no layouts or documentation for publication, other than views created specifically for the creation of 2D or 3D model files (DWG or IFC, respectively).
6.3 Referencing

6.3.1 External reference 2D information – DWG

DWG files from external sources can be dealt with in three distinct ways. The data can be added as an External Drawing, added as an Xref or added to a separate PLN, adjusted and then added to the project as a Hotlink. Each method has its own pros and cons. In general it is advisable to add 2D DWG data to a worksheet.

DWG data added as an External Drawing enables separate control of, for example, Layers and Pen Set within the individual Drawing’s Settings, within the project.

DWG data added as an Xref enables overall control of Layers, which will be added as a separated set within the Layers dialogue. When an Xref is deleted, its associated attributes can also be removed. Xref data can also be loaded and unloaded and updated from a later Xref. The DWG should be opened with an appropriate translator. If changes are made to the translator settings it is advisable to save that translator with a separate name.

Adding DWG data to a separate PLN enables data to be processed separately from the main project data. For example layers or other attributes can be consolidated. The DWG should be opened with an appropriate translator. Once information is ready for use it can be hotlinked, copied into a project file or used as an Xref.

Data added as an External Drawing or an Xref is not able to be controlled by the renovation filters.

Consideration should be given to the renovation status of data that is copied or bound in from a DWG file which by default would be set to existing.

*Note: It is of particular importance to check the scale of any added external data after import to ensure it is correct.*

6.3.2 External reference 3D information - IFC

Model files from external sources, other than ARCHICAD, should be received in IFC format, opened in a separate ARCHICAD session and saved as a single-user PLN file and stored within the project filing structure.

It is recommended that layers within files received from an external source are not amended. This is particularly true when IFC files will be issued regularly to the ARCHICAD user.

Where multiple IFC models are received, for import into a project, use of the merge function will reduce the risk of misreading profiles (this is less of an issue in ARCHICAD 19 and above as profiles from external IFC files can be ignored at import).
7 Modelling Methodology

7.1 Model Development Methodology

An ARCHICAD model consists primarily of parametric elements, but not everything will be modelled. The primary aim is to create fully coordinated information. Sometimes it will be hard to resolve difficult problems in 3D - but there are tools to help visualize problems. Resolving issues at an earlier stage will make life much easier and more straightforward downstream.

ARCHICAD’s parametric elements can be quickly and easily modified throughout the WHOLE project at any stage. It is not necessary to get everything right at the outset when only the generalities are known - not the specifics.

ARCHICAD’s method of controlling views with View definitions containing variable ‘Model View Options’, ‘Layer Combinations’, ‘Dimension styles’ etc. enables the same model information to be viewed in completely different ways for different purposes. Views of the model can be defined to suit the stage of the project, whether it be Concept Design, Developed Design or Technical Design. It is imperative that new users understand and can control the power inherent in View definitions.

Although it is not necessary to enter detailed element information at the outset of a project it is very important to place these elements accurately. Any inaccuracies will be carried forward with potentially disastrous consequences!

7.1.1 Office Template(s)

An Office Template(s) is at the heart of successful BIM implementation in GRAPHISOFT ARCHICAD. Templates dictate that all new projects work to an agreed consistent standard and ensure the highest quality delivery.

The templates shall be created by the person responsible. Template files should be saved and maintained and updated as required, but particularly at new version releases.

Much of this document includes many aspects that affect an ARCHICAD template and this document should be used for guidance in developing company templates. A checklist of items (based on ARCHICAD 19) is provided under separate cover.

In addition to the items listed in Appendix 11.3, companies should establish a Central Resource Library (see 10.3.2) and also translators for data exchange.

*Note: It is recommended that no libraries, other than the ARCHICAD library are attached to the template where multiple servers are used.*
7.1.2 Project Specific Template(s)

All projects should always commence by using the latest agreed company Office Template(s). These should then be updated at the commencement of a project to reflect project information and other project requirements.

Each project should have a template file(s) saved and these should be stored with the project (see Appendix 11.2). Instructions should be provided to users as to what information needs to be setup to create a Project Template.

Users should therefore always start a new file from the Project Template.

*Note: Files should never be created by duplicating project files. Content and information should also never be copied from other projects. This is extremely dangerous practice, particularly with respect to attributes.*

7.1.3 Teamwork

Projects requiring simultaneous access by more than one user should be shared as a Teamwork project setup on a BIM Server / BIMcloud. Any project started as a solo project can be shared at any time for multi-user access on the BIM Server / BIMcloud.

BIM Server(s) / BIMcloud should be appropriately named and managed by the person responsible. Always follow the recommendations set out by Graphisoft for hardware specifications and BIM Server setup.
7.1.4 Composite Structures

Composite structures should be named and setup in a consistent and logical manner to aid navigation through the project.

When creating Composite Structures it is important to bear in mind the position of the reference line for the element. The following are recommended:

- Ceiling - Reference line to bottom
- Roof – Reference line to bottom
- Slab – Reference line to top
- Walls External – Reference line can be either provided companies are consistent. There are justifications for both methods. (For information - ARCHICAD’s template Composite Structures are set to external). *
- Walls Internal – Reference line to centre of wall or as otherwise agreed where spatial dimensions are critical for particular spaces *

Note: Users should be aware that composite structures export as a single element unless “Explode Composite and Complex Profile elements in parts” is selected in the Geometry Conversion Options of the IFC Translator settings.

Skins can also be excluded at export by ensuring that the Building Material required to be excluded has the “Participates in Collision Detection” unchecked and choosing “Export geometries that “Participates in Collision Detection” only” in the Geometry Conversion Options of the IFC Translator settings.

* The RICS prescribes measurement along the centre line of all walls therefore this should be noted when measurements are required.

7.1.5 Building Materials

Building Materials should be named and setup in a consistent and logical manner to aid navigation through the project.

ARCHICAD’s Building Materials are a combination of a Cut Fill with a Surface. The Pens and Fill Orientation will be inherited from the Cut Fill but can be reset. Each Building Material will have its own Intersection Priority which it may be necessary to reset depending on the use of the Building Material within the Project and its position within Composites.

Building Materials have their own Tags and Categories settings including Physical Properties. The Physical Properties have been set in accordance with international standards. If new Building Materials are created it is important to obtain the correct Physical Properties particularly if it is intended to use it for environmental analysis.

Care should be taken with the length of names. For example if a 3DS file is exported to Autodesk 3DS Max from ARCHICAD only the first 16 characters are visible. This number of characters can still be somewhat limiting in ARCHICAD so a recommendation of no more than 24 characters (including spaces) is advised.
Note: IFC translators can be set to control how Surfaces of a Building Material are exported. The colour will be the RGB value set in the Surface Colour for any Surface.

By default, where BREP export is set in the IFC translator, this will export one body colour per element. This will be the top listed skin in a composite buildup. It does not consider surfaces set with the ‘Override’ option.

Where the IFC Translator is set (under Geometry representation) to ‘Explode Composite and Complex Profile elements into parts’ this will export a separate colour for each element of, for example the Composite, with its associated Surface Colour.

The above needs to be considered if colour is required to be exported.

7.1.6 Profiles

Profiles should be named and setup in a consistent and logical manner to aid navigation through the project.

A Profile can be assigned to a Wall, Beam or Column. Profiles should only be allocated to the element(s) that they will be used for.

Typically, the origins for Profiles will be placed as follows:

- Wall – Base of the wall to either the left or right hand side depending on the reference line
- Beam – Top and centre
- Column – Centre

When creating profiles, the profile editor will automatically put one selection point at the origin/reference line, with the associated tool adding further ones at the extremities of the element. Users can also add to these using the hotspot tool within the profile editor. These will define nodes on the profile for selection and manipulation. Generally this should be done on an ad hoc basis, but a good guide is to put one at every fill node used to create the profile.

Graphically define and/or adjust the calculation method of component’s surface area, if needed.

Note: Particular care should be taken with profiles when using hotlinks on a project to ensure the attributes in all connected files match.

7.1.7 Zone Categories

ARCHICAD users should set up Zone Categories suitable for the type and scale of the project(s) within their Office Template.

Zone Category colours should also match the model colour so that the 2D and 3D representation are the same.

Zones should be modelled accurately to ensure reliable data exchange with other software and accurate results with EcoDesigner or EcoDesigner Star thermal...
analysis. Where Zone data is being used for data exchange or thermal analysis, the zones should always be associative not manually drawn. This will ensure they are linked to the enclosing walls. Use of the ‘Update Zone’ command can check the associativity of zones.

Where a Zone can not be bounded by a wall, a line can be used, providing it is set to ‘Zone Boundary’ in the Line Dialogue.

Zones should not enclose or be intersecting with other Zones. Such use of Zones will cause scheduling and thermal analysis to be inaccurate, and cause problems where data is exchanged.

Where Zones are required for rooms which have more than one ceiling height the use of the BIM will affect how they should be modelled. For thermal analysis multi height Zones should be formed from one Zone trimmed with solid element operations. If such Zones are exported via IFC only some receiving software will interpret this correctly so exchange tests will be necessary. If data is required for COBie it may be necessary for the Zone to be modelled to the lowest height.

Note: It should be noted that Zones actually represent Spaces (IfcSpace) and that actual Zone data is managed within the IFC Manager.

7.1.8 Surfaces

Surfaces should be named and setup in a consistent and logical manner to aid navigation through the project.

Surface definitions such as colour, texture, vectorial hatching and light effects should be aligned and matched with all default 3D Engines (Internal, OpenGL and CineRender).

7.1.9 Model View Options

Model View Options should be named and setup in a consistent and logical manner to aid navigation through the project. The following is a recommended format for naming -

<table>
<thead>
<tr>
<th>Field 1:</th>
<th>Field 2:</th>
<th>Field 3:</th>
<th>Field 4:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Role</td>
<td>Number</td>
<td>ModelView</td>
<td>Description</td>
</tr>
</tbody>
</table>

Field 1: **Role** *(Optional)*

Field 2: **Number**

A sequential number with 2 digits. (01, 02, 03 etc)

Field 3: **ModelView** *(Optional)*

Adding this field aids navigation, particularly in Quick Options palette.
Field 4: Description

Description of Model View and should be in CamelCase.

Example: E.g. A-03-ModelView-Ceiling

All fields should be separated by hyphen.

Information displayed using Model View Options should be appropriate for the stage of the project. For example, full detailed wall constructions would not need to be displayed at an early design stage of a project but would be required at a later stage.

7.1.10 Scale

Models should always be modelled at a scale of 1:1, however in ARCHICAD, the scale of the model can be set in the display and this can be used to display different information on the published output.

ARCHICAD represents certain objects, zones, doors and windows with relevance to different scales. Due attention should be paid to choose the right scale before creating Views.

7.1.11 Floor Plan Cut Plane

The Floor Plan Cut Plane should be determined on a project-by-project basis according to project requirements. By default the international an UKI ARCHICAD templates are set to 1100mm. When establishing a height for the cut plane, please bear in mind heights of window cills. The Floor Plan Cut Plane can also be adjusted by View as required.

Note: Particular attention needs to be made where more than one building exists in a project and each building uses different floor-to-floor heights. Generally buildings with different floor heights should be modelled in separate files although this is not always ideal particularly regarding the Floor Plan Cut Plane.

7.1.12 Partial Structure Display

The Partial Structure Display is one of the data filters that allow users to control how elements in the model are displayed. Users define the skins of composite elements to be ‘core’, ‘finish’ or ‘other’. It is then possible to display elements in any view of the model to show: ‘Entire Model’, ‘Without Finishes’, ‘Core Only’, and ‘Core of Load Bearing Elements Only’. It is necessary to use this function in conjunction with the classification of an element’s ‘Structural Function’ (under Tags and Categories for an element) to achieve the last Partial Structure Display option.

The function will control the display in any current window and can be set to control the display in any saved View definition. This enables the export of appropriate data to other consultants, in IFC or other formats. View definitions can be set specifically for this purpose.

Where dimensions are referenced to elements set to a particular Partial Structure Display they are specific to that Display only. If the Partial Structure Display is
changed, those dimensions will be suppressed. It is therefore important to set the appropriate Partial Structure Display before dimensioning strings are added.

It can be useful to use the Trace Reference function to display a view with a different Partial Structure Display to the one in the current window to compare the two.

7.1.13 Solid Element Operations (SEO)

This is a method for carrying out a subtraction of one element on another element(s). The element that carries out the subtraction is typically placed on its own layer so that it can be hidden.

Whilst this functionality offers great power to the user it needs to be used with care. The following need to be given due consideration when using Solid Element Operations -

- Size of file
- Scheduling
- Number of SEO’s to an element
- Ecodesigner

7.1.14 Energy Evaluation

ARCHICAD’s Energy Evaluation tool performs reliable dynamic energy evaluation at any stage of the design process. The Location data must be defined either using a predefined ‘City’ or by giving precise longitude or Latitude values.

As a prerequisite to Energy Evaluation the building model must contain at least:

The enveloping structures, windows and major internal structures that represent significant heat storage mass.

ARCHICAD zones placed in every conditioned space of the building - the model's analysis is based on these Zones. Zones must be associative and associated with the enclosing elements, if necessary using Solid Element Operations. Always Update Zones after any change to the model and before running Energy Evaluation.

The Energy Model Review uses visible elements only. A view dedicated to the energy model, including zones, should be created.

Ensure that the correct Operation Profiles are used or alternatively create ones specifically for the project.

Prior to running the Energy Evaluation it is important to assign Appropriate Building Systems and Operation Profiles to the Thermal Blocks and set Energy Source Factors and Energy Costs.

Ensure that when the Energy Evaluation tool is run there is an open connection to the internet to enable the download of the appropriate Climate Data.

To ensure consistent results with Energy Evaluation, use ARCHICAD’s modelling elements as far as possible for the purpose for which they are intended. The following conventions should be followed.
The Mesh tool to model the building’s ground levels, especially if uneven.

Do not use multiple separate parallel walls (or slabs or roofs) to model composite structures. If such constructions exist in the building model, ensure that only one of the parallel structures is visible in the energy model, and that the adjacent Internal Space Zones touch that structure.

Use Cut Fills consistently within the project: a particular fill should always indicate the same single building material or composite.

Note: Marquee selection does not filter building elements for the purpose of Energy Evaluation.
7.2 Graded Component Creation

7.3 Drawing Compilation

Views should be assembled within the model file with the correct settings for placement on the layout sheet as drawings. Views should be named logically in accordance with Office Standards and typical Views can be set up in the Office Template as a source for appropriate View settings. More on View Naming is covered in Section 8.8. Views are defined with the following settings:

- Layer Combination
- Scale
- Structure Display
- Penset
- Model View Options
- Renovation Filter
- Floor Pan Cut Plane Settings
- Dimensions
- Zoom Factor

*Note: While it is possible to 'right click' in the 'Project Map' and select ‘Save View and place on Layout’ or drag from the Project Map onto a Layout, neither of these options should EVER be used! Both will result in an unstructured set of Views in the View Map, which will be subsequently undecipherable. Settings in Views should never be set to ‘custom’.*

7.3.1 Sheet composition direct from within the BIM

7.3.2 Sheet composition from Views/Output files
7.4 Spatial Location & Co-ordination

As defined in **BS1192:2007+A1:2015**, BIM projects shall:

- Use real world co-ordinate systems:
- Be produced to true height above project datum.
- Adopt the established Project Shared Coordinate system across all BIM data files to allow them to be referenced without modification.

Whilst the above rules are sacrosanct, ARCHICAD workflow dictates that individual building models are best created orthogonally to the screen and at zero elevation. The location of the building in terms of real-world co-ordinates, true heights and shared co-ordinate systems are all established and managed within the site model.

CAD files that use real-world co-ordinates whereby data is more than 100km from the origin (in any plane) need to be modified prior to import into ARCHICAD and information shall be shifted closer to 0,0,0. This shift shall be agreed, consistent and documented in the Project BIM Execution Plan.

*Note: Co-ordinates above 100km from the origin will begin to lose accuracy the further they are away from the origin. This will also cause file slow down and issues of ‘flickering’ in some software. Ideally the model should be as close to the origin as is practical.*

Real-world co-ordinates are then re-established in the ARCHICAD environment and site / true locations are managed within.

Data exported from ARCHICAD can then be either real-world or local and whilst the majority of data will need to be delivered in OS co-ordinates for the purposes of collaboration and cross-referencing, some software (e.g. certain structural analysis software) requires data to be located at 0,0. For export to such software, local coordinate systems must be utilised.

Model exchange should always be from real-world co-ordinates and therefore should always be exported from the site model rather than the building model.
7.4.1 Large sites (Local Scale Factor)

For large sites there is a potential for the curvature of the earth to play a factor in terms of the site setting out. In particular, while Ordnance Survey National Grid coordinates are based on a ‘flat earth’ projection, actual measurements on site are typically based on a ‘round earth’, which can lead to significant setting out discrepancies when projected over long distances.

It is typically beneficial for all sites to be set out based on a ‘flat earth’ model in order to be able to tie into the Local Project Grid derived from the Ordnance Survey National Grid and more easily reference in important features surrounding the site (e.g. utilities connections etc).

In order to resolve the potential round earth / flat earth discrepancies an Ordnance Survey Projection or Local Scale Factor (LSF) must be applied. The LSF varies according to location across the UK, but often (i.e. typically for individual sites, as opposed to regional studies) a uniform site specific LSF can be applied without introducing significant errors. This LSF should be obtained / calculated as early as possible to ensure a uniform topographic base is being used across the entire project.

Assuming a ‘flat earth’ basis; all design models, drawings and associated setting out information should be based upon the Local Project Grid derived from the Ordnance Survey National Grid coordinates, (standard northings/eastings etc). Site setting out for construction activities will typically need to incorporate ‘control stations’ at regular intervals to ensure that round earth / flat earth discrepancies are ‘smoothed out’ over the length and breadth of the site. (If possible this should be agreed in principle with the site setting out team prior to commencement of design activities.)

All site topographic surveys should be commissioned such that the output has been converted to OS National Grid using the site specific LSF prior to use for design purposes.
7.5 Units and Measurement

See main AEC (UK) BIM Technology Protocol for recommendations regarding units and measurement.

ARCHICAD users have control over Working Units and Dimension Units separately from the Options > Project Preferences Menu. A set of Dimension Unit options can be set and saved with a name for selection under the View definition settings. These should be set up in line with the recommendations made in the AEC (UK) BIM Technology Protocol. The following is a recommended format for Project Preference naming -

Field 1: **Number**
- A sequential number with 2 digits. (01, 02, 03 etc)

Field 2: **ProjectPreference** *(Optional)*
- Adding this field aids navigation, particularly in Quick Options palette.

Field 3: **Description**
- Description of Project Preference and should be in CamelCase.

Example: 01-ProjectPref-Standard

All fields should be separated by hyphen.

The options for Calculation Units & Rules, Zones, Construction Elements and Reference Levels should be setup under the Project Preferences and will be specific to that project. They therefore need to be set in the Office or Project Specific template file (.tpl).

Units and Measurement should be setup within the companies Office Template and not deviated from without prior agreement from the person responsible.
8 Folder Structure and Naming Conventions

8.1 Introduction

8.2 Project Folder Structure

8.2.1 Central Resource Folder Structure

Standard templates, Central BIM Resource Libraries, Attribute files, Translators, Favourites, Schedules, Work Environment Profiles etc and other non-project specific data shall be held within a central location, with restricted write access.

Central resources shall be organised by software and version. A central resource will be stored centrally for access by all appropriate staff. This may be a server, intranet, extranet etc. depending on company systems and access requirements.

8.2.2 Local Project Folder Structure

Generally files should not be stored on local machines. The only exceptions are when files are copied purely for viewing purposes or a Teamwork Travel Pack has been generated to allow a user to work offline whilst out of the office.

8.3 General Naming Conventions

8.4 File Naming
8.5 Division Naming

ARCHICAD is managed using a combination of Layers (with associated Layer Combinations) and Renovation Status to manage division of information.

8.5.1 Layers

ARCHICAD uses Layers to manage both data within the modelling environment and also for control of output CAD and BIM data. It is recommended that the layering system is in accordance with the recommendations made in the AEC (UK) Technology Protocols.

Layers are used for both managing CAD and BIM data and so it needs to be understood that some other software will be able to view and use layers as a way of filtering information.

The person responsible should establish a base set of Layers suitable for the type and scale of work and include these within an Office Template.

It is recommended that Layers are documented outside ARCHICAD for both ARCHICAD users and for others who wish to utilise the layers. This document should be included as an Appendix to the Project BIM Execution Plan.

Layers additional to the Office Template that have been added by the project team should also be documented in the Project BIM Execution Plan.
8.5.2 Layer management

Layers within GRAPHISOFT ARCHICAD can be managed using Layer Combinations. The person responsible should setup standard Layer Combinations within the Office Template.

Layer Combinations should be named in a consistent and logical manner to aid navigation through the project. The following is a recommended format for naming -

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Role</td>
<td>Number / Classification</td>
<td>Description</td>
</tr>
</tbody>
</table>

Field 1: **Role**

Role in line with AEC (UK) BIM Technology Protocol Section 11.1

Field 2: **Number or Classification**

Classification reference in line with agreed classification system or other numeric code in line with project requirements.

Field 3: **Description**

Description of Project Preference and should be in CamelCase.

Example: A-10-Prep-SettingOut-Building or A-20-Ceiling-ReflectedCeilingPlan

All fields should be separated by hyphen.
8.5.3 Renovation filters and renovation display

Elements can be set to an Existing, Demolished or New status. Elements can then be filtered depending on what needs to be displayed for different views of the model. This is done with Renovation Filters.

Renovation Filters should be named and setup in a consistent and logical manner to aid navigation through the project. The following is a recommended format for naming -

1. **Number**
   - A sequential number with 2 digits. (01, 02, 03 etc)
2. **Renovation** *(Optional)*
   - Adding this field aids navigation, particularly in Quick Options palette.
3. **Description**
   - Description of Renovation filter and should be in CamelCase.

Example: 01-Renovation-Existing

All fields should be separated by hyphen.

8.6 Library Object Naming

It is recommended that the standard ARCHICAD library maintain the original naming as shipped with the product. Any vendor-supplied object which is altered in any way by the user is to be treated as a new element and named / stored accordingly in either the Central BIM Resource Library or Project BIM Resource Library.

Objects imported from external sources, or internal objects copied to create a project-specific library shall use a consistent naming convention in line with the recommendations made in the AEC (UK) BIM Technology Protocol or as agreed in the Project BIM Execution Plan.

Where Library Objects are added to a Project they may by default be added to the ‘Embedded Library’. While this may be satisfactory for an Unshared project it is not suitable for a Teamwork Project or one with many Hotlinks. In such cases an external Project Library or BIM Server Library (as appropriate) needs to be established and objects should be removed from the Embedded Library to this.
8.7 Object Property Naming

GRAPHISOFT ARCHICAD contains standard IFC Property Sets. These Property Sets allow the user to complete standard fields in line with the IFC standard. Each type of element within a model will contain different data depending on how the element has been classified in the Element Classification field.

Whilst the standard IFC Property Sets are built-in to the software, ARCHICAD also allows companies and individuals to add additional Property Sets based on their needs. Data can either be added at a project level or an element level.

Project level IFC can be added at File > File Special > IFC2x3 > IFC Scheme Setup

Additional Property Sets should be added at the appropriate level. The person responsible should consider the company's standard data needs and add these to the Office Template.

The naming of any new Property Set and property set data should avoid conflict with the standard Property Sets and therefore should be named in the following format:

```
1: Custom Identifier
2: Property Set
3: Description
```

Field 1: **Custom Identifier**

This an identifier for the creator of the Property Set to distinguish it from a standard Property Set. So for example a company called Joe Bloggs Architects might use JBA OR alternatively a user could use Additional.

Field 2: **Property Set**

Should state Pset.

Field 3: **Description**

Description of Property Set and should be in CamelCase.

Example: JBA_Pset_General OR Additional_Pset_General

All fields should be separated by an underscore.

Individual data for each Property Set should be added as CamelCase and care should be taken to ensure spelling is correct.
8.8 View Naming

Views should be named in a consistent and logical manner to aid navigation through the project. Views should be assembled in folders, which should also be organised and named in a consistent and logical manner to aid navigation through the project.

Different approaches to View naming have been utilized but organizations should be consistent in their approach. The following is an example of how Views might be handled:

<table>
<thead>
<tr>
<th>Field 1:</th>
<th>Level/Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Field 2:</td>
<td>Classification (Optional)</td>
</tr>
<tr>
<td>Field 3:</td>
<td>Description</td>
</tr>
</tbody>
</table>

Field 1: **Level/Location**

This is the code from the Project Map where coding has been used to identify elements in the model. For example, level 01 would be 01.

Field 2: **Classification (Optional)**

Classification reference in line with agreed classification system.

Classification is not required for cloned Views.

Field 3: **Description**

Description of View name

Example: 01-2530-WindowDetails

All fields should be separated by hyphen.

*Note:* Cloned Views automatically take the name of the View that they have been created from. These cannot be amended and therefore may not follow the naming convention.
8.9 View List Scheduling

Project Indexes are table of contents type items listed in the Project Map of the Navigator palette. They can display and access lists of views, layout sheets and drawings based on a set of filtering criteria. In particular, View lists can filter and list views by their location in the Project Map, their scale, name, model view option combination, layer combination, pen set, structure display settings, dimensioning standard, renovation filter and publishing status.

8.10 Data Organisation

8.11 Sheet Naming
9 Presentation Styles

9.1 Introduction

This section defines the criteria which ensure the plotted appearance of drawing output from the BIM is consistent and of the highest quality.

9.2 AEC (UK) Compliant Materials

To be developed in due course.

9.3 Annotation

9.4 Text Assignment

All text shall be restricted to the following sizes:

<table>
<thead>
<tr>
<th>Text height (mm)</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.8</td>
<td>General text, dimensions, notes – used on A3 &amp; A4 size drawings</td>
</tr>
<tr>
<td>2.5</td>
<td>General text, Dimensions notes</td>
</tr>
<tr>
<td>3.5</td>
<td>Sub-headings,</td>
</tr>
<tr>
<td>3.5</td>
<td>General text, dimensions, notes – A0 drawings</td>
</tr>
<tr>
<td>5.0</td>
<td>Normal titles, drawing numbers</td>
</tr>
<tr>
<td>7.0</td>
<td>Major titles</td>
</tr>
</tbody>
</table>
9.5 Line Weights

Line weights or Pen weights as they are more commonly known within ARCHICAD can control the graphical display of on-screen data as well as all published output.

The plotted/printed appearance of modelled components shall be:

- Consistent across the project
- Represented in a manner that provides ‘depth’ to the final published output and allows for adequate differentiation of elements cut in section, profile view and priority elements

Pen weights on published information are controlled within ARCHICAD by a combination of the Pen number selected and the chosen Penset.

The following is a recommended format for naming of Pensets -

<table>
<thead>
<tr>
<th>Field 1: Role</th>
<th>Field 2: Number</th>
<th>Field 3: Penset</th>
<th>Field 4: Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Field 1: **Role** *(Optional)*
Role in line with AEC (UK) BIM Technology Protocol Section 11.1

Field 2: **Number**
A sequential number with 2 digits. (01, 02, 03 etc)

Field 3: **Penset** *(Optional)*
Adding this field aids navigation, particularly in Quick Options palette.

Field 4: **Description**
Description of Penset and should be in CamelCase.

Example: A-01-Penset-Model

All fields should be separated by hyphen.

There are 255 pens within ArchiCAD.

Generally it is recommended that pen weights are restricted to the following where possible – 0.13, 0.18, 0.25, 0.35, 0.50, 0.70, 1.00, 1.40 and 2.00mm. These are in line with ISO 128.
9.6 Line Patterns

In GRAPHISOFT ARCHICAD, Line Patterns are referred to as Line Types.

Line Types are used for all draughting production work. It is recommended that the Line Types provided with the standard ARCHICAD template are maintained. Additional Line Types required should be added after the final line type attribute in the template file. These can be added into an office template or added to project specific files as required.

9.7 Line Styles

See 9.6 Line Patterns.

9.8 Hatching and Filled Regions

Default Fill Patterns for Model and Draughting, which are loaded into the default templates, should be used.

- Alternative Fill Patterns shall be used only with the approval of the person responsible.

- Fills shall be created using the relevant tools available within the software.

- Where possible, hatch patterns should be assigned to the relevant materials for the elements, rather than assigned as 2D patches.

- Care shall be taken to ensure that the draw order and transparency settings of filled regions are appropriate to the situation so as not to cover required graphical information.

  Note: Cut fill patterns within ARCHICAD form the exported IFC material for Objects and therefore care should be taken to ensure the cut fill chosen reflects the material of the element it is cutting through.

9.9 View Templates

See 7.3 Drawing Compilation.

9.10 Dimensioning

See the generic AEC (UK) BIM Technology Protocol.

It should also be noted that elements that may be replaced later in the process should not be dimensioned to. For example, a structural frame produced by the architect will be replaced by a Structural Engineer's frame and subsequently by a Fabricators model. Dimensions should therefore be to a reference point rather than the element itself.

Also great care should be taken to ensure that the correct Partial Structure Display is set before utilizing dimensions.
9.11 Drawing Borders and Title Blocks

- Corporate titleblocks should be setup within the Office Template(s) on Master Layouts. Layouts should be created for each standard paper size (e.g. A4, A3, A2, A1 and A0).

- Examples of drawing sheet templates are contained in Appendix E of ‘A Standard Framework and Guide to BS1192’.

- In ARCHICAD, information on title blocks can be automated to update fields on multiple sheets. Careful consideration should be given to what can be fully automated. Information that can be automated should then be set as Autotext on the Master Layout sheet(s).

To aid the user it is recommended that the office template has as many fields completed as possible and that ‘dummy’ text is inserted in other fields the user is required to complete. E.g. Against Project Name it has in the required field Project Name. The user should then amend the fields in the Project Info dialogue box (available under File > Info > Project Info) as required.

Information from Project Info and Book Settings > Layout Scheme can be used as Autotext. Data from Layout Scheme can be scheduled whilst data from Project Info can not. Consideration should be given to reuse of data for other purposes before deciding whether to create/use data fields.

- Project-specific title blocks shall be created by amending the Office Template and saved as a Project Specific Template(s) within the project folder structure (see Appendix 11.2).

9.12 Symbols

Standard symbols such as north points, dimension bars, etc. are stored within the appropriate BIM Resource Libraries.

North points should be included on all building and site plan information.

9.13 Copyright
10 Resources

10.1 Introduction

10.2 Software

10.3 BIM Content / Resource Libraries

BIM Resource Libraries hold objects, textures and other data for use within CAD and BIM files. They may also hold macros, textures and user interfaces which are utilised by some BIM objects. These are generally not used directly by the user and care should be taken to ensure relevant supporting information is contained within the correct library.

Although ARCHICAD supports the use of embedded libraries, these are not recommended for large or Teamwork projects and all content should be stored within with a Central BIM Resource Library or a Project BIM Resource Library as appropriate.

*Note: The only exception to this rule is for Property Objects on Teamwork projects, which are best embedded.*

Central BIM Resource Libraries can get very large and it is recommended to break them into sub-folders so that only those types of objects required for a particular project are loaded and not the whole library.

See also the generic AEC (UK) BIM Technology Protocol.

10.3.1 Custom ArchiCAD Objects

Any created / downloaded ARCHICAD GDL objects should all have preview images.

ARCHICAD objects should also ensure that the correct Subtype is selected before incorporation into the Central BIM Resource Library or Project BIM Resource Library. *Note: This is particularly important when it comes to IFC export.*

10.3.2 ARCHICAD Library

Each version of ARCHICAD is provided with a standard library for use with that specific version. All project files should have the ARCHICAD library loaded by default. When a project moves from one version of ARCHICAD to another it is advisable to ensure that the Library for the current version is loaded plus the appropriate ‘Migration Libraries’ back to the file’s original version.
10.3.3 Central BIM Resource Library

- Content shall be segregated by software product and version.

When content is updated for use in newer product version:

- The original data shall be maintained,

- The updated version of the content shall be created in the appropriate location for that product & version. This avoids ‘forwards incompatibility’ when using content with the version of the software for which it was originally created.

10.3.4 Project BIM Resource Library

This shall be the repository for the storage of project specific content where additional content is required due to project or client requirements.

- Objects, textures and other data produced in the process of completing the project shall be held within the Project BIM Resource Library (refer to Appendix 11.2).

- The Project BIM Resource Library may be held within the project folder structure or on larger projects, on a BIM Server / BIMcloud. On Teamwork projects this Library must be uploaded to the BIM Server / BIMcloud as a BIM Server Library. If this Library was loaded when the project was shared, the appropriate BIM Server Library will be created automatically.

- On a Teamwork project, any new Library objects must be added to the Project BIM Resource Library. This must then be used as the source to refresh the appropriate BIM Server Library.

- Libraries should be clearly named to make it clear which project they are attached to.

- No more than one project specific library should be attached to each project, except where more than one project is combined into a wider site or central model.
10.4 Keynotes

10.5 Custom metadata

Meta data within ARCHICAD can either come from object parameters or from IFC data. Generally speaking it is recommended that IFC data fields be used where possible, although object parameter data can be linked to IFC data fields as required to allow the user to input into object parameter fields.

Careful consideration should be made to what data is required at the appropriate stages in projects.

10.5.1 Favourites

ARCHICAD allows the user to configure elements and objects with specific settings. This allows company standards to be developed within the Office Template. For objects these can be configured for geometry, 2D/3D display, layer allocation, and data requirements and for elements for 2D/3D display, layer allocation and data requirements.

Favorites are considered an integral part of data delivery for BIM projects using ARCHICAD. Creating them allows the development and control of company standards and greatly enhances productivity.

Users should also be encouraged to utilise Favorites wherever possible.

10.5.2 ARCHICAD object parameters

ARCHICAD allows users to input data directly into objects as part of the object settings. This can be done by linking the object data to IFC parameters.

10.5.3 IFC data

ARCHICAD comes with many in-built IFC ‘Property Sets’. These are developed along standards documented by buildingSMART. (The technical website can be found here - http://buildingsmart-tech.org/ifc/IFC2x3/TC1/html/index.htm).

As a minimum for successful exchange of geometry (and of course data) particular importance is placed on ensuring that the Element Classification is correctly assigned. It should also be noted that some Element Classifications also have ‘Predefined Types’. So for example a ‘floor finish’ would be classified by a user as a Covering (IfcCovering) but they would then also need to select a predefined type of FLOORING from the menu.

Particular care should be given to elements that are modelled with a tool that is not specifically designed for its original purpose. For example, ARCHICAD’s slab tool can be used for slabs (floors) but also for ceilings, raised access floors and floor finishes. Users should ensure the Element Classifications are defined correctly.

It should be noted that the user is not expected to complete every standard field but companies should determine their standard company requirements. Project
requirements may then deviate where necessary and this should be documented in
the Project BIM Execution Plan.

10.5.4 COBie data

GRAPHISOFT have produced a guidance document regarding COBie data input
into ARCHICAD. This is available at
http://www.graphisoft.com/support/ifc/downloads/. Locations for where this data is
entered into ArchiCAD is contained within the GRAPHISOFT documentation.

In order to assist in COBie delivery it is recommended that the following Contact
data is input into the Office Template.

- Category
- Company
- Phone
- Street
- PostalBox
- Town
- StateRegion
- PostalCode
- Country

This reduces the need for repeated entry of data and ensures consistency across
projects.

Project Templates should add the following Contact data when a project template is
created.

- Email
- GivenName
- FamilyName

If known, it is also recommended to insert the following Facility (Project, Site and
Building) data to the Project Template.

- Name
- Category
- ProjectName
- SiteName
- Description
- ProjectDescription
- SiteDescription
- Phase

Again if known, the following Floor (BuildingStorey) data to the Project Template.

- Name
- Category
- Description
10.6 Keyboard Shortcuts

Generally users should endeavour to use the keyboard shortcuts provided with the standard ARCHICAD template.

However, ARCHICAD does allow users to have shortcuts and other user specific settings. These settings are controlled within the Work Environment Profile (WEP).

The Work Environment Profile is available under the ARCHICAD or Options menu bars. Users may setup User Preference Schemes, Shortcut Schemes, Tool Schemes, Palette Schemes and Command Layout Schemes. Users however should not deviate from agreed office Company Standard Scheme.

Where a user chooses to setup their own WEP they should store each profile option with an appropriate name. For example, if Joe Bloggs wanted to have his own Shortcut Scheme he should save this as Joe Bloggs SS19 (where 19 is the version). Once each setting has been saved the user should then set up a WEP with the required Profile Options. This should then be named appropriately e.g. Joe Bloggs WEP 16.

Once the WEP is created this should then be exported and stored centrally on a server for use with other projects or on other machines as required.

It is recommended that users setup WEP’s for each version and do not import previous WEPs as this can lead to some functionality being lost.

11 Appendices

11.1 Model File Naming Codes
11.2 Project Folder Structure

The following folder structure is provided as an example arrangement, designed to encourage compliancy with the strategies contained within this protocol.

This is provided as an example only and should not be used in preference to or replace any internal company quality assured standard folder structures. Always consider your company processes and procedures, especially if ISO accreditation is involved before adopting change.

- **[Project Folder]**
  - **[BIM]**
    - **[01-WIP]**
      - **[BIM]**
      - **[Export]**
      - **[WIP_TSA]**
    - **[02-Shared]**
      - **[CAD]**
      - **[BIM]**
      - **[CoordModels]**
    - **[03-Published]**
      + **YYYYMMDD-Description**
      + **YYYYMMDD-Description**
    - **[04-Archived]**
      + **YYYYMMDD-Description**
      + **YYYYMMDD-Description**
    - **[05-Incoming]**
      - **Source**
      + **YYYYMMDD-Description**
      + **Source**
    - **[06-Resource]**
      + **Logos**
      + **ProjectBIMResourceLibrary**
      + **ProjectTemplates**
      + **Standards**
      + **Translators**

[BIM data repository]

[WIP data repository]

[Verified Shared data]

[CAD data/output files]

[Design models]

[Compilation models]

[Sample submission folder]

[Sample submission folder]

[Archive folder]

[Archive folder]

[Data originator]

[Incoming folder]

[Data originator]

[Project BIM Resources Library]

[Project logos]

[Project specific BIM content]

[Project specific templates]

[Project standards]

[Project translators for DWG, IFC etc]

No spaces or special characters are to be used in the folder naming as this can potentially interfere with certain file management tools and collaboration across the internet.